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ABSTRACT 

Alzheimer’s disease (AD) is a complex, multifactorial, progressive, neurodegenerative disease primarily 
affecting the elder population and is estimated to account for 50–60% of dementia cases in persons over 
65 years of age. Natural products, including plants, animals and minerals have been the basis of 
treatment of human diseases. Secondary metabolites have been the most successful source of potential 
drug leads and continue to provide unique structural diversity in comparison to standard combinatorial 
chemistry, traditional medicinal practices have formed the basis of early medicines followed by 
subsequent clinical, pharmacological and chemical studies which provides opportunities for discovery 
for many novel low molecular weights lead compounds. In silico approach has been of great importance 
as a versatile tool to develop fast and accurate target identification and prediction method for the 
discovery. Traditionally docking was used as computational tool for screening databases of natural 
products to mine a set of a few candidate drug-like compounds. Reverse docking was a comparatively 
new application of docking in which a database of proteins (drug targets) was docked against a set of 
natural products to predict binding affinities. Therefore, plant extracts may in future provide more 
effective medicines than the single purified natural products of modern medicine, in some cases. Studies 
on identification of compounds from traditionally used medicinal plants to cure neurodegenerative 
diseases and brain injuries is increasing scientific interest in recent years as this a major concern in 
public. In Ayurveda the roots, seeds and leaves of Clitoria ternatea have been widely used as brain tonic 
and believed to promote memory and intelligence. Hence the present study was designed to assess the 
Alzheimer’s activity of Clitoria ternatea and to identify and isolate the major bioactive constituent 
attributing the activity. 
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INTRODUCTION 
Alzheimer’s disease (AD) is a complex, 
multifactorial, progressive, neurodegenerative 
disease primarily affecting the elder population 
and is estimated to account for 50–60% of 
dementia cases in persons over 65 years of age. 
The impairment of central acetylcholine (ACh) 
neurotransmission due to neural degeneration 
is believed to be a principal neuropathological 

feature of Alzheimer’s disease. AD occurs in two 
forms: familial and sporadic. In familial AD, 
mutations in the amyloid precursor protein 
(APP), presenilin 1, and presenilin 2 genes are 
the currently known causal factors. Familial AD 
constitutes only a small portion (2-3 %) of all AD 
patients and it has an early age of onset 
(younger than 65   years). On other hand, 
sporadic AD, constitutes a vast majority of AD 
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cases and is associated with a late age of onset 
(65 years and older). Although the specific 
causes of sporadic AD are still unknown many 
causal factors seem to be involved in sporadic 
AD, including aging, mitochondrial defects, 
insulin-dependent diabetes, environmental 
conditions and diet. In familial AD, genetic 
mutations accelerate the disease process, 
whereas in sporadic AD due to absence of 
genetic mutation, cellular changes that control 
AD progression take more time to develop.  AD 
progresses gradually and can last for decades. 
Enzymatic hydrolysis of acetyl choline (ACH) is 
an important step in the nerve transport, and 
its defect results in Alzheimer’s disease.[1, 2, 3] 
Ellmann’s method is used for determination of 
Cholinesterase activity and also for monitoring 
of the ACH hydrolysis by acetyl cholinesterase. 
The original colorimetric procedure is based on 
the reaction of thiocholine (one of the products 
of enzymatic hydrolysis of ACTH) with DTNB, 
forming yellow colour product5-mercapto-2-
nitrobenzoic acid. The maximum absorption 
coefficient found at 412nmThe reaction is 
shown below:[4] 

Acetyl thiocholine  →   thiocholine   +   acetate 
Thiocholine + Dithiobis-Nitrobenzoate  →  5-
mercapto-2-nitrobenzoic acid (yellow colour) 
 
PLANT PROFILE [5] 
Botanical Name: Clitoria ternatea 
Common Name: Butterfly pea, Blue pea and 
Cordofan pea 
Synonyms: Asphota, Girikarni, Visnukranta, 
Sankhapuspi, Sephanda, Sveta, Maha 
Family: Fabaceae 
whole plant [6] 

 
HISTORY 

From ancient times “Shankhpushpi” is known as 
reputed drug of Ayurveda and reported as a 
brain tonic, nervine tonic and laxative. It is 
considered as a “Medhya Rasayana” in 
Ayurveda. It is an Ayurvedic drug used for its 
action on the CNS (Central Nervous System), 
especially for boosting memory and improving 
intellect. The flowers of the plant Clitoria 
ternatea resemble a conch shell; therefore it is 
commonly called “Shankhpushpi” in the 
Sanskrit language where it is reported to be a 
good “Medhya” (brain tonic) drug and, 
therefore, used in the treatment of “Masasika 
Roga” (mental illness). Extracts of this plant 
have been used as an ingredient in Medhya 
Rasayana, are juvenating recipe used for 
treatment of neurological disorders. [7] 

 
HABITAT AND DISTRIBUTION 
Clitoria comprises 60 species distributed mostly 
within the tropical belt with a few species found 
in temperate areas. The plant is well adapted to 
various climates. The plant originated from 
tropical Asia and later was distributed widely in 
South and Central America, West Indies, China 
and India. [8] 

 
PLANT DESCRIPTION 
Clitoria ternatea has twining fine stems 0.5-3 m 
long. The leaves are pinnate with 5-7 elliptic to 
lanceolate leaflets 3-5 cm long and shortly 
pubescent underneath. Flowers are solitary, 
deep blue to blue mauve; very short pedicellate 
and 4-5 cm long. Pods are flat, linear, beaked, 6-
12 cm long, 0.7-1.2 mm wide and slightly 
pubescent with upto 10 seeds. The seeds are 
olive, brown or black in colour, often mottled, 
4.5-7 mm long and 3-4 mm wide. [8] 

Table: Taxonomical Classification [6] 

Kingdom Plantae 

Order Fabales 

Family Fabaceae 

Genus Clitoria 

Species ternatea 

THERAPEUTIC USES 
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The juice of flowers is reported to be used in 
insect bites and skin diseases. The roots are 
useful in asthma, burning sensation, ascites, 
inflammation, leucoderma, leprosy, hemicrania, 
amentia, pulmonary tuberculosis, 
ophthalmology and reported as bitter, 
refrigerant, ophthalmic, laxative, diuretic, 
cathartic, aphrodisiac, tonic. They are 
considered safe for colic, dropsy and 
enlargement of abdominal viscera. The root, 
stem and flower are recommended for the 
treatment of snake bite and scorpion sting in 
India. [7, 9] 

 
METHODS AND MATERIALS 
COLLECTION AND IDENTIFICATION OF PLANT 
MATERIAL 

Dried Roots of Clitoria ternatea (CT) were 
collected in February 2013 from commercial 
market, Attingal, Thiruvananthapuram, Kerala. 
The plant material was identified and 
authentified by Dr. K. V George, Department of 
Botany, C M S College, Kottayam, Kerala. The 
dried roots were pulverized by an electric 
blender and the coarse powder was stored in an 
air tight container. 
 
PREPARATION OF EXTRACT[10] 

Hexane extract preparation (HE): 100g 
powdered root material of CT were macerated 
with 250ml of Hexane for seven days at room 
temperature and shaken occasionally for 
extraction. The resulting extract was filtered 
and the filtrate obtained was evaporated to 
dryness using a rotary evaporator to yield 
hexane extract of CT. The marc was dried and 
used for further extraction.  
 

Alcoholic extract preparation (AE): The dried 
marc was placed in a thimble and extracted 
with 250ml of ethanol in a Soxhlet apparatus for 
72 hrs. The extract was filtered and evaporated 
to dryness to yield Alcoholic extract of CT. 
 

Aqueous extract preparation (AQE): The dried 
marc was mixed with 300 ml of distilled water 
in a reflux condenser for 3-4 hrs. The extract 
obtained was filtered and evaporated to 
dryness to yield aqueous extract of CT. All the 
dried extracts obtained were weighed and yield 
of each extract calculated. 
 
IN VITRO FOR ANTICHOLINESTERASE 
INHIBITION ASSAY (ELLMANN’S METHOD) [11, 12, 

13, 14] 

PREPARATION OF SAMPLE SOLUTION OF 
CLITORIA TERNATEA 
50 mg of each extracts was weighed and was 
dissolved in 50 ml of water to produce 1mg/ml. 
From the stock solution, various concentrations 
ranging from 25 to100 µg/ml were prepared. 
 
PREPARATION OF 0.1M PHOSPHATE BUFFER PH 
7.4 
5.44g of potassium di hydrogen phosphate was 
dissolved in 200 ml of distilled water and 0.84g 
of sodium hydroxide was dissolved in 100 ml of 
distilled water separately. From above solutions 
62.5 ml of potassium di hydrogen phosphate 
was taken and was added 48.7 ml of sodium 
hydroxide. It was made up to 200 ml with 
distilled water. 
 
PREPARATION OF SUBSTRATE ACETYL 
THIOCHOLINE IODIDE (ATCI) 
0.02167g of acetyl thiocholine iodide was 
dissolved in 10ml of 0.1 M phosphate buffer 
and stored in refrigerator for use. 
 
PREPARATION OF REAGENT 5, 5’-DITHIOBIS-2-
NITROBENZOIC ACID (DTNB) 
0.0396 g of 5, 5’-dithiobis-2-nitrobenzoic acid 
and 0.015g sodium carbonate were dissolved in 
10 ml of 0.1M Phosphate buffer and used for 
study. 
 
PREPARATION OF ENZYME  
Venous blood was collected into dried 
heparinized tubes and subjected to 
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centrifugation. Plasma was removed carefully 
without losing any erythrocytes. The 
erythrocytes are then suspended in water in a 
volume corresponding to the initial volume of 
whole blood, followed by 60-fold diluted with 
buffer (0.1M Phosphate buffer PH7.4). Then the 
suspension had frozen in order to haemolyse 
the erythrocytes. [15] 

 
METHOD 
To 0.4 ml of enzyme and 0.5ml 5, 5’-dithiobis-2-
nitrobenzoic acid, 0.4 ml of sample was added 
and incubated for 15 minutes at 25oC. The 
reaction was then intitated with the addition of 
0.1ml of acetyl thiocholine iodide. The rate of 
absorbance was monitored at wavelength 412 
nm. The AchE inhibitory activity was calculated 
using the equation:[12, 13, 15, 16] 
 

A- (B-C)*100/A 
 
A represents Control (Reagents + solvent + 
Enzyme) 
B represents Sample (Reagents + Sample + 
Enzyme) 
C represents Blank of Sample (Reagents + 
Sample + solvent) 
 
CHEMICAL PROFILING OF BIOACTIVE 
(AQUEOUS EXTRACT) BY LC-MS METHOD 
Aqueous Extract was resuspended in water and 
used for LC-MS study. The Column used was 
Phenomenex RP 18, 25cm × 2.5mm and the 
Mobile Phase Acetonitrile: Methanol in the 
ratio 50:50 was used for the study. The 
ionization mode used was Electron spray 
ionization. Ionization range was at 50-1000. The 
Software used for identification Class was VP 
integrated Library (Metwin 2.0). [17] 

 
DOCKING STUDY WITH IDENTIFIED 
COMPOUNDS FROM LC-MS WITH RECEPTOR 
4FRJ [18, 19, 20] 

STEPS INVOLVED IN AUTODOCKING  

Rigid docking was performed and hence, 
protein and the ligand molecule were non-
flexible. Here Amyloid β protein (PDB ID: 4FRJ) 
was used as receptor and ligand molecules 
were all the constituents identified in the 
aqueous extract of Clitoria ternatea using LC-
MS. 
 
PREPARATION OF RECEPTOR 
The Auto dock software was opened by clicking 
on Auto dock icon from desktop. 
 The downloaded PDB molecule 4FRJ in the 
work space panel was read by clicking on the 
tab “File”and then selected “Read molecules 
 
Hydrogen Atoms and Charges 
The tools available in ADT were used to read 
coordinates in PDB and other formats, to add 
hydrogen, to selected portions of the molecule, 
and to add partial charges. These functions 
were all accessed through menus at the top of 
the ADT window.  
• File> Read Molecule: Opens a browser that 
allows reading of PDB coordinate files. 
• Edit> Delete: Several options for deleting 
entire molecules, selected sets of atoms or   
hydrogen atoms. 
• Edit> Hydrogen> Add: Options for adding all 
hydrogens or polar hydrogens. 
• Edit> Charges: Options for computing 
Gasteiger charges for arbitrary molecules. 
• File> Save> (receptor.PDBQT 
 
PREPARATION OF LIGAND 
Prepared ligands can be processed in the 
“Ligand” menu to create the ligand PDBQT file. 
Ligand> Input> open: reads coordinates from a 
file. 
 Ligand> Input> choose: chooses a molecule 
already read into ADT 
Ligand> Torsion Tree> Choose Root: manual 
selection of the root atom. 
 Ligand>Torsion Tree> Detect Root: Automatic 
detection of the root that provides the smallest 
largest sub tree. 
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Ligand> Output: Opens a browser to write the 
formatted ligand. PDBQT file. 
 
GENERATION OF GRID 
For docking calculations using rigid receptor 
coordinates, the hydrogen atoms and charges in 
ADT, were added. 
 
OPENING THE RIGID PROTEIN 
Grid> Macromolecule> Open: Launches a 
browser to open an existing PDBQT file. 
Grid> Macromolecule> Choose: Chooses a 
molecule that has been previously read into 
ADT. Merged non-polar hydrogen atoms and 
charges, assign aromatic carbons, and prompt 
the user to write a PDBQT file. 
 
PREPARATION GRID PARAMETER FILE 
Select> select from string > Residue> name of 
active site found by Q site finder> add> dismiss: 
Select the residue to be flexible. 
Display> label> by properties> select name and 
number> from one or more properties> Ok. 
Grid> grid box: Interactive commands were 
launched for setting the grid dimensions and 
center. The numbers were entered on the 
thumb wheel, placed the cursor over the thumb 
wheel and type the new value. Right clicking on 
the thumb wheel gave more options. 
IMPORTANT: when finished, use the “close 
saving current” option in the “File” menu on the 
Grid Options Panel. Options in the “Center” 
menu on the browser provide different 
methods to choose the center of the grid box. 
Grid> Output> save by grid.gpf: Save grid 
settings as gpf file. 
 
PREPARING DOCKING PARAMETER FILE (.DPF) 
Docking> Macromolecules> Set rigid filename 
(choose receptor.PDBQT): Specifying the rigid 
molecules. 
Docking> Ligand> choose> (choose 
ligand.PDBQT) > accept: Specifying the ligand 
molecules. 

Docking> Search parameter> Genetic 
Algorithm>( for first time short number of 
evaluations and  for other runs choose medium 
or long> accept: Setting the parameters  chosen 
for the docking method. 
Docking>docking parameters> choose the 
defaults: Setting docking parameters. 
Docking> Output> Lamarckian GA> dock.dpf:  
The name was specified on the ligand dpf file to 
be formed, containing the docking instruction. 
 
RUNNING OF DOCKING 
Pwd Enter 
Cd folder: Enter 
Cd folder (sub folder) Enter 
./autogrid4.exe –p grid.gpf –l grid.glg 
./autogrid4.exe –p dock.dpf –l dock.dlg 
Visualization of docking was done by chimera. 
 
ISOLATION OF BIOACTIVE CONSTITUTENT 
 DETERMINATION AND OPTIMIZATION OF 
SOLVENT SYSTEM BY TLC [21, 22, 23, 24] 

 PREPARATION OF THE THIN LAYER 
CHROMATOGRAPHY (TLC)  
The TLC plate was prepared by suspending silica 
gel G powder in distilled water. The slurry was 
poured carefully on to the glass plate to get 
uniformly coated plates. The plates were air 
dried and kept in an oven at 100-120°C about 30 
minutes for activation. 
 
DETERMINATION OF SOLVENT SYSTEM 
SOLVENT SYSTEM 
Different solvent systems viz Toluene: Ethyl 
acetate, Toluene: Chloroform: Ethanol, Ethyl 
acetate: acetic acid and Toluene: Ethyl acetate: 
Acetic acid were tried out to select the suitable 
solvent system for the identification of 
maximum chemical constituents present in 
aqueous extract 
 
THE COMPOUND ON TLC PLATE  
The origin is marked by drawing a thin line 
across the bottom of the plate with a pencil. 
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The aqueous extract was spotted with a glass 
capillary tube on to the plate.  
 
RUNNING OF TLC 
The spotted plate was placed into the saturated 
chamber; preventing the sample from dissolving 
from the plate into the eluent layer.  When the 
eluent reaches 3/4of the plate, the plate was 
removed from the chamber.  The point that the 
eluent had reached is called the eluent front 
and was immediately marked with a pencil. The 
plate was dried by allowing the eluent to 
evaporate form the plate.   
 
VISUALIZATION OF SPOTS ON TLC PLATE 

A developed TLC plate was sprayed with Vanillin 
sulphuric acid and visualized spots were 
marked. Distance travelled by solute and 
solvent was measured to calculate the 
Retardation factor of solute using the following 
equation 
Rf =   Distance travelled by solute front 
          Distance travelled by solvent front 
 
ISOLATION OF CHEMICAL CONSTITUTENT BY 
COLUMN CHROMATOGRAPHY 

PACKING OF COLUMN 
A cylindrical glass column was taken and 
plugged with a small piece of cotton. 
Mounted the column on the stand. 
Weighed 20 g of fresh silica gel (for column 
chromatography 60-120 mesh) into a 250 mL 
beaker. 

Mixed with 100ml of Toluene: Ethyl acetate 
(8:2) into the beaker was stirred well using a 
glass rod to made slurry of the silica. 
Poured the slurry into the column. 
Placed a beaker below the mounted column to 
drain out the excess solvent. 
Closed it when the level of the solvent reached 
just above the settled silica gel. 
 
PREPARATION OF SAMPLE 
5g of aqueous extract was dissolved with eluent 
and equal amount of silica gel was added to it. 
Mixed thoroughly by continuous stirring in one 
direction till solvent got evaporated. 
 
METHOD[25, 26, 27] 

For column chromatography sample was loaded 
on to the column packed with adsorbent silica 
gel G (100-200 mesh). The mobile phase was 
added from the top of the column and allowed 
to flow down by gravity. Elutants was collected 
from the bottom of the column and was stored 
as fractions of 10 ml. Each fraction was analyzed 
by TLC and those with same pattern were 
pooled. Fifth fraction which gave a single spot 
and Rf similar to the bioactive constituent, β-
sitosterol was evaporated and subjected to IR, 
NMR and MASS spectroscopy studies. 
 
RESULT  
EXTRACTION YIELDS 
Extractive yields for each extract were 
calculated and Aqueous extract found have 
more yield than other two extracts.

 
Table: Extractive Yields of Various Extracts of Clitoria ternatea 

S.l:No: Extracts Extractive Yield of dry Sample (g) 

1 Hexane (HE) 3.20 

2 Alcoholic (AE) 2.66 

3 Aqueous (AQE) 3.48 

 
Preliminary screening 
The preliminary phytochemical screening of hexane extract, alcoholic extract and aqueous extract were 
done to identify the phytoconstituents and the results obtained were tabulated in the table. 
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Table: Phytochemical Screening 

Sl.No: Chemical Tests Observation Inference 

 
 

Detection of Alkaloids  HE AE AQE 

Mayer's test Yellow ppt - + + 

Wagner’s test Reddish ppt - + + 

Dragendroff’s test Red ppt - + + 

Hager’s test Yellow ppt - + + 

Detection of carbohydrates Violet ring at the junction of test 
tube 

 
- 

 
+ 

 
- Molisch’s test 

 Benedict’s test Red ppt - + - 

Fehling’s test Red ppt - + - 

Detection of Glycosides Rose pink colour in 
the ammonical layer 

 
- 

 
+ 

 
- Modified Borntrager’s test 

Legal’s test Blood  red colour - + + 

Detection of Phytosterols  
Golden yellow colour 

 
+ 

 
- 

 
+ Salkowski’s test 

Libermann Burchard’s’ test Formation of brown ring at the 
junction of test tube Yellow ppt 

+ 
 

- + 

Detection of Phenols  
Bluish black colour 

 
- 

 
+ 

 
+ Ferric chloride test 

Detection of  Flavonoid’s     

Alkaline reagent test Intense yellow colour - - + 

Lead acetate yellow colour - + + 

Detection of Tannins     

Ferric chloride test Greenish ppt - - + 

Potassium Hydroxide Dirty white ppt - - + 

Detection of Saponins Formation of 1cm layer foam  
- 

 
+ 

 
+ Froth test 

Foam test Foam produced persists for ten 
minutes 

- + + 

Detection of Proteins and 
amino acids 

yellow colour  
 
- 

 
 
- 

 
 
- Xanthoproteic test 

 
ANTI- CHOLINESTERASE ACTIVITY BY ELLMAN’S METHOD 
The extracts were tested for their inhibitory effects against acetyl cholinesterase and compared with 
neostigmine as standard. The results obtained were tabulated in the table 
Table: Percentage inhibitions obtained for anti- cholinesterase assay 

S.l.No: Concentration % Scavenging 

1. Standard (Neostigmine) 25 68.53 

50 82.64 

75 83.25 

100 84.88 
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2. Hexane Extract 25 42.08 

50 42.91 

75 44.72 

100 45.69 

3. Alcoholic Extract 25 53.32 

50 62.50 

75 64.81 

100 68.04 

4. Aqueous Extract 25 75.69 

50 77.63 

75 78.55 

100 79.86 

 
A graph was plotted taking Concentration on X-axis and percentage scavenging on Y-axis and results 
were depicted in the figure 

Figure: Concentration Vs.  Percentage Inhibition 

 
 
From the graph, IC50 values were calculated for 
each extract and standard. The values were 
tabulated in the table and graphically 
represented in the figure 
Table: Comparisons of IC50 values of various 
Extracts with Neostigmine 

S.l:No: Extracts IC50 (µg/ml) 

1 Neostigmine 
(Standard) 

10 

2 Hexane 100 

3 Alcoholic 22 

4 Aqueous 12 

Figure: Graphical representations of IC50 Values 
of extract with Neostigmine 

 
LIQUID CHROMATOGRAPHY - MASS 
SPECTROSCOPY 
In order to identify chemical composition of the 
bioactive extract, LC/MS studies were 
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performed, and the identified constituents on 
comparison with data in class VP integrated 

Library were tabulated in the table.

 
Table: Identified constituents by LC/MS 

S.l:No: Compounds Molecular Weight 

1 Kaempferol 286.23 

2 Taraxerol 426.72 

3 Beta- Sitosterol 414.71 

4 Hexacosanol 382.71 

5 Tyrosine 181.19 

6 proline 115.13 

7 Threonine 119.12 

8 Lupeol 426.72 

9 Ellagic acid 302.19 

10 Catechin 290.26 

11 Methyl amino- L- alanine 118.13 

12 Amino butyric acid 103.12 

13 Petunidin- 3-Glucoside 514.87 

14 1,3,6 tri galloyl glucose 636.46 

15 Sennoside A 862.72 

16 Alpha- Crytoxanthin 552.87 

17 Quinine 324.42 

18 Alpha- Erythroidine 273.32 

19 Di-methoxy 4- Hydroxyl Acetophenone 196.20 

20 Lupinine 169.26 

 
DOCKING STUDIES 
In protein docking with 4FRJ, the docked poses were analyzed and lowest binding energy obtained and 
the no: of hydrogen bond formed between protein and ligand were tabulated in the table 
 
Table:In silico studies 

Sl.No Compounds Structure Docking score Hydrogen Interaction 

 
1 

 
Kaempferol 

 

-6.58 2 

 
2 

 
Taraxerol 

 

-3.67 1 
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3 

 
Beta- 

Sitosterol 

 

-9.99 1 

 
4 

 
Hexacosanol  

-1.54 0 

 
5 

 
Tyrosine 

 

-4.52 1 

 
6 

 
proline 

 

-3.50 1 

 
7 

 
Threonine 

 

-4.11 2 

 
8 

 
Lupeol 

 

 
-9.61 

 
1 

 
9 

 
Ellagic acid 

 

-6.81 - 

 
10 

 
Catechin 

 

-6.07 3 

 
11 

 
Methyl 

amino- L- 
alanine  

-3.61 1 

 
12 

 
Amino 

butyric acid  

-2.87 1 

 
13 

 
Petunidin- 

3-Glucoside 

 

-2.37 1 
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14 

 
1,3,6 tri 
galloyl 
glucose 

 

-6.21 6 

 
15 

 
Sennoside A 

 

+1623.37  
1 
 

 
16 

 
Alpha- 

Crytoxanthi
n 

 

 
+176.13 

 
1 

 
17 

 
Quinine 

 

 
-7.11 

 
2 

 
18 

 
Alpha- 

Erythroidine 

 

 
-6.89 

 
0 

 
19 

 
Dimethoxy-
4- hydroxyl    
Acetopheno

ne  

 
-3.92 

 
1 

 
21 

 
Lupinine 

 

 
-5.57 

 
2 

Interaction of protein with best two ligand β - Sitosterol was depicted in the figure 
Figure: Interaction of β – Sitosterol with Amyloid β protein 
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Docking score (-9.99) 
 
ISOLATION OF BIOACTIVE CONSTITUTENT 
TLCprofile obtained for Aqueous extracts of Clitoria ternatea in various solvent system were tabulated in 
table 
Table: TLC profile 

S.l:No Sample Mobile phase Spot Rf value 

1. Aqueous Extract Toluene: Ethyl acetate (80:20) 1 0.64 

 
Best TLC profile was obtained for Toluene: Ethyl acetate in the ratio 80:20 and the spot 1 showed Rf 
value similar to β-sitosterol 
 
Characterization of isolated compound 
The isolated compound is a white crystalline compound, melting point experimentally found to be 
138oc.IR Spectroscopy shown in (figure) reveals that OH Stretching (3292.58), C-H aliphatic stretching 
(2925.90, 2855.42), C-O   stretching (1228.00) CH2 stretching (1450.58), C=C stretching (1650.58). From 
1H- NMR (Figure) showed there were signals found in 0.793,1.06 due to 2 methyl singlet, 0.82 due to 
methyl doublet , 0.835due to methyl triplet, 5.31 due to substituted olefinic bond. From C- NMR(Figure) 
shows signals at 31.94, 21.46 and 29.71. The weak molecular ions were given at m/z 414 and other ion 
peaks are m/z 271, 273 due to the formation of carbocation by β bond cleavage of side chain leading to 
the loss ofC10H21 and C10H23 that corresponds to the M‐141and M‐143. 
 
IR Spectrum of isolated compound 

 
 
1H-NMR Spectrum of isolated compound 
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12C-NMR Spectrum of isolated compound 
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Structure of isolated compound 
The physical and spectral 
data are consistent to the 
reported literature values. 
From the data’s of 
spectroscopic studies it 

was confirmed that isolated compound was β-
sitosterol. 
 

DISCUSSION 
Alzheimer’s disease is a neurodegenerative 
disorder due to the impairment of 
Acetylcholine. In traditional practices of 
Ayurvedic and Chinese medicine, numerous 
plants have been used to treat cognitive 
disorders, including neurodegenerative diseases 
such as Alzheimer's disease. The herbs acting on 
the brain are called No-otropic herbs and their 
isolated constituents are referred to as smart 
drugs. In my thesis work I selected Clitoria 
ternatea for Alzheimer’s diseases, extraction 
was carried out by using different solvent based 
on their polarity hexane, alcoholic and aqueous 
extracts and their yield were calculated. All 
extracts were subjected to preliminary 
photochemical screening to identify the 
phytoconstituents present in each extracts. The 
activity of acetyl cholinesterase was done by 
Ellmann’s method; used for monitoring 
cholinesterase activity and also Ach hydrolysis 
by acetyl cholinesterase. From the study 

aqueous extract found to have higher activity 
was compared with Neostigmine, activity was 
comparatively less than standard. A graph was 
plotted concentration on x- axis and percentage 
inhibition on y-axis and IC50 values were 
calculated.  Chemical profiling of bioactive 
aqueous extract by LC-MS to identity chemical 
composition and obtained mass spectrum of 
identified compounds were compared with 
class VP integrated library. In silico studies on 
identified compounds from LC-MS were docked 
with receptor Amyloid β protein (4frj) using 
auto dock software. The highest docking score 
was for β-sitosterol. Isolation of bioactive 
constituent was carried out by TLC studies and 
column chromatography. Various solvent 
systems were screened to select the best 
solvent system (Toluene: Ethyl acetate) in the 
ratio 80:20. TLC profiling of column fractions, 
fifth fraction gave similar Rf value (0.64) similar 
to β-sitosterol, the isolated compound was 
subjected to spectroscopic analysis. The 
identified compound may play vital role against 
poor also in memory.  
 

CONCLUSION 
The present study shows the Aqueous extract of 
Clitoria ternatea can be used against 
Alzheimer’s disease. The isolated compound 
may act as a lead compound for identifying new 
derivatives which could use for improving 
memory. 
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